SOP 
CNC FIBER LASER FABCREATOR SOFTWARE 
Training is required before using this equipment 
Closed Toed Shoes required 
Steel Toe Protection required 
Eye & Ear Protection required 
Safety Gloves required 
Never leave machine unattended while operating 
 
[image: Fablight laser engraving and cutting system]
FIBER LASER SPECIFICATIONS 
MAXIMUM MATERIAL DIMENSIONS: 
SHEET 
Width x height (X,Y): 50” X 25” 
Thickness: SEE ‘APPROVED MATERIAL’ 
SQUARE/RECTANGLE/ROUND TUBE 
Diameter:0.5” to 2” 
Length: 3” to 80” 
Tube must be 3” longer (1½” per side) than the size of the job being cut. 
APPROVED MATERIAL: 
MILD STEEL – 0.25 MAX CUT THICKNESS - COLD ROLLED ONLY 
ALUMINUM – 0.188 MAX CUT THICKNESS  
COPPER – 0.0480 MAX CUT THICKNESS 
BRASS – 0.0800 MAX CUT THICKNESS  
STAINLESS STEEL – 0.188 MAX CUT THICKNESS 
 (also see ‘Material Cutting Instructions’) 
TITANIUM – 0.0350 MAX CUT THICKNESS (also see ‘Material Cutting Instructions’) 
bronze, nickel, gold, inconel, nitinol, silicon steels, silver, titanium, 4130 chromoly, and more. (See NIS Staff) 
 
OPERATIONS: 
CUT 
ENGRAVE 
RASTER 
This SOP covers the Fiber Laser software, FabCreator. FabCreator is loaded on all studio PC’s. FabCreator is a subscription software and is not available for download. To operate the fiber laser see the Operator Manual SOP. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
MATERIAL CUTTING INSTRUCTIONS 
Hot rolled steel may never be cut, rastered, or engraved on this laser. Hot rolled steel contains mill scale and will destroy the laser lens.  
[image: Parts with burnt electrical connections]
 
Only cold rolled steel is allowed. 
Material must be free of all oils, grease, paint, and any other foreign residue. 
Cutting of cold rolled steel, aluminum, copper, and certain gauges of stainless steel is performed using pressurized air. 
Stainless steel thicknesses of 7 gauge (0.188) may require the use of nitrogen to obtain satisfactory results. Test your cut with air first. If you do not obtain the desired results you will need to use nitrogen. 
Titanium will require the use of nitrogen for all cuts. 
There is an additional per-minute charge for cuts when using nitrogen. When you create your cut files using FabCreator you will need to make a note of the total cut time and pay when your job is complete. See NIS staff for current cost. 
For cut time instructions see the ‘JOB’ TAB’ section under ‘Step & Repeat’ in the FabCreator Software SOP. 
To set up the laser for nitrogen use see the ‘Gas Feed Selection’ section of the Operator Manual. 
  
 
 
 

CREATING YOUR FILES 
 
The FabLight Fiber Laser uses CAD software to create your part files and FabCreator to create your cut files. All files must be created on the computer lab PC’s and imported to the fiber laser via flash drive. The following process must be followed to ensure a successful finished part. 
1. When designing a sheet part file you must create a .dxf file using a CAD design program such as VCarve, Solidworks, Fusion 360, AutoCad, or similar. Your part file must be exported as a .dxf. Illustrator is not recommended. Illustrator creates splines, which are not supported in FabCreator. CAD software create arcs, which are supported in FabCreator. A possible work around is to bring your AI file into VCarve first. See the ‘USING VCARVE WITH FABCREATOR’ section at the end of this SOP. 
 
2. When designing a tube part file you must create a .dxf file using 
Solidworks to design your file, then use the ‘3D Fab Plugin’ in Solidworks to convert the weldment components into geometry that can be cut using the 4-axis laser. It works similarly to Solidworks’ built in ‘Convert to Sheet Metal’ function. See the ‘USING 3D FAB PLUGIN’ section. 
 
3. When creating your cutting file (the file that will be imported on the laser to perform the cuts) you must use a proprietary software called FabCreator. You will import your .dxf file into FabCreator, create your cutting files, or .fab files, save the .fab file to a flash drive, then open your .fab file on the Fiber Laser. This software is not available to download on your personal device. See the ‘USING FABCREATOR’ section. 


USING FABCREATOR 
· Open FabCreator 
 
[image: fab creator desktop logo]
· Open your file by clicking on <File>Import> for a .dxf file or <File>Open> for an existing .fab file. 
· A ‘Units’ pop up will open. Select the units in which your file was designed. 
· In the ‘Placement’ section it is recommended to check ‘Move to origin before placing’. 
· TheAuto Place setting will automatically move the imported object outside of any existing object previously imported. 
 
[image: sheet metal import menu]
· FabCreator checks imported files for entities that are within the “Join tolerance” value (default 0.2mm) distance from each other and automatically tries to join them into a single entity. If those close by entities are themselves smaller than the “Join tolerance” value, you will see the Join Warning below upon importing a file because FabCreator will not be sure which end of each small entity to attempt to join. 
[image: join warning]
 
· If the file looks ok click ok. If not, you can either lower the join tolerance or make the small features on your drawing larger. 
ACTION TABS 
On the left side of your screen you will see 5 tabs listed horizontally under ’Combo View’ named Part, Edit, Properties, Process, Job. 
 
[image: fab creator software ribbon]

‘PART’ TAB 
Click on the ‘Part’ tab and the tree structure of your imported part(s) will appear in the sidebar. Expand the tree by clicking on the “>” arrow in front of your part. This will reveal the process groups: cut, engrave, raster, and reference. 
 
· Cut=Green. Represents geometry to “cut” 
· Engrave=Red. Represents geometry to “engrave” (engraves the geometry lines only) 
· Raster=Blue. Represents geometry to “raster” engrave (fills in between the geometry lines of a closed shape, i.e. text.) 
· Reference=Black. Represents geometry that will not be cut or engraved. (Representation of the material you will be cutting your parts from, or any other geometry that is reference only and no process is required.) 
 
When a part is initially imported, all geometry items are green, unless your part has open vectors (see NIS staff for details). If you need to change the process for certain geometry you can select the items by clicking on the line in the tree or by clicking on the polyline itself on the right side of screen. Multiple items can be selected using the ‘Box Selection’ icon in the upper left toolbar or by holding down the Ctrl key while clicking multiple items. The selected items will now be yellow. 
 
 
[image: Box Selection button]
To change geometry to a different process follow these steps. 
· Expand the ‘Cut’ tree. 
· Select the geometry you want to move to another process (see above). 
· Drag the geometry to the desired process. The geometry image will now change to the appropriate process color. 
 



‘EDIT’ TAB 
After the geometry items are all in the appropriate Groups, click on the Edit tab, revealing four possibilities: Move/Rotate Part, Move to Origin, Delete and Text. 
 
[image: modify objects menu]
 
Move/Rotate Part 
 
[image: move part menu]
 
 
· Move the part 1 mm at a time on the X & Y axis by using the green arrows. 
· Undo movements by clicking ‘Move part to Origin’. 
· Rotate the part by specified degrees by typing the degrees in the white box 
· Rotate the part in 90 degree increments clockwise or counterclockwise by clicking on the rotate arrows. 
· Click ‘OK’ to save changes. 
Move to Origin 
If on import the “Move to Origin” checkbox was unchecked, or you have since moved a part, clicking on Move to Origin gives you four options for repositioning the part relative to the origin: Move to Origin, Move to X Origin, Move to Y Origin, and Reset Position. 
 
[image: move to origin menu]
 
NOTE: Moving the part to the origin in FabCreator is different from where on the machine the part will be cut. The origin in FabCreator will end up being the lower-left corner of the “bounding box” for the part, or the soft home. The part itself can still be placed anywhere on the bed of the machine by jogging the cutting head. 
 
Delete 
Directly clicking on geometry in the image and then clicking Delete will remove it, as will double clicking geometry then pressing the Delete key.  
Text 
Text is best created in your CAD software. All imported text is automatically assigned to the engrave group. If you want to raster your text, follow the ‘Part’ tab function. 


‘PROPERTIES’ TAB 
The Properties tab contains your Database, Catalog, Sheet Properties, Engrave, and Raster settings. 
 
[image: properties menu]
 
Always select FL4500. 
Catalog 
The Catalog section allows you to pick from the material database within FabCreator. 
· Units – Inches or millimeters, based on file design specifications. 
· Type – Sheet or Tube. Shape options for tube are rectangle, round, square. 
· Material – Steel, stainless, aluminum, copper, titanium. 
· Material Type – Typical. 
· Engrave/Raster Settings – always set to Default. 
Sheet Properties 
The Sheet Properties section lets you choose the material thickness. 
· Use calipers to determine the thickness of your material in decimals. 
IT IS CRITICAL THAT YOU MEASURE YOUR MATERIAL AND SELECT THE CORRECT THICKNESS FROM THE DROP-DOWN OPTIONS. 
· Your material thickness options are limited to the laser’s capabilities. • If the material you wish to use is not listed in the database, see NIS staff. 
 
By default, the “Auto Sheet Size” box is checked. The bounding box is shown in white as the minimum rectangle needed to enclose the part (see below left). 
*Verify that your part will fit onto your material by unchecking the box and type in the X and Y dimensions of your material (below right). 
[image: Sheet properites with 'auto sheet size' selected. (Wrong)]	 	 


Tube Properties 
When the Tube Type is chosen in the Catalog section, the Tube Properties section lets you pick the tube dimensions, wall thickness, and other properties depending on the tube shape. All tube parts must be designed using Solidworks and the Solidworks plugin. 
	 
[image: tube properties menu]
	Round: Only the Diameter and Wall Thicknesscan be specified. 
 
For all tube types (round, square, and rectangle)the Tube Length is optional, and can be used forpreviewing the job in a way similar to Auto SheetSize, as described in Sheet Properties above. 

	 
[image: square tube properties menu]
	Square: The Width and Wall thickness can bespecified. 
 
In addition, the Corner Radius should be pre-defined based on the type of material. It is possible to override the corner radius by choosingCustom and filling in a value. An alternative is to pick a Tube Diagonal (or enter one in), which grays out the Corner Radius (and vice versa). 

	 	[image: rectangular tube properties menu with tube in horizontal orientation. ]
 	[image: rectangular tube properties menu with tube in verical orientation]
	Rectangle: This is very similar to Square, exceptthe Long Side (A) and Short Side (B) are enteredseparately. 
 
There is also a check box to Rotate Wrap 90 degrees. The A and B values stay the same, butthey are essentially swapped on the wrap. You’ll see the corner lines in the drawing adjust appropriately. 


 
The actual value of a corner radius can vary greatly from one tube manufacturer to another, especially for stainless steel and steel square tubes. The default value is a value that works for many tubes. It can be changed if your part is having trouble cutting on square corners. See NIS staff for assistance. 
Since FabCreator imports 2D drawings, the “height” of the part drawing for an unwrapped tube must match the perimeter of the tube it will be cut from. In order to help visualize this, FabCreator shows a white box to represent the unwrapped dimensions of the tube as chosen in Tube Properties. 
 
The image below shows a 0.5-inch round tube file (green) with an (incorrect) 1.255-inch tube selected in the material properties (white). Note the white box is not the correct size. 
 
[image: Tube properties menu]
This next image shows a 0.5-inch round tube with the correct 0.5-inch tube selected in the material properties. Also note the orange dashed line that FabCreator overlays onto the part to indicate that it will wrap exactly around the tube. 
 
[image: Preview of file for tube cutting]


Square & Rectangle Tubes 
Innovation Studio computers are loaded with a Solidworks weldment plugin that contain predetermined corner radii for some common square tubes. Based on your tube wall thickness, verify your tube corner radius against the chart below. If your tube is not represented in this chart, see NIS staff. 
 
 
	Wall Thickness (in) 
	Corner Radius (in) 

	0.065 
	0.07 

	0.120 
	0.13 

	0.180 
	0.25 

	0.250 
	0.38 


 
For Square and Rectangle tubes, FabCreator shows the corners, and the start and finish of each corner radius, as groups of three dashed white lines. For the example shown, the split line for the unwrap is in the middle of one of the flat faces, and the four corners can be clearly seen. This is helpful for seeing where features will show up for each face of the cut. 
The orange dashed lines on the two ends that indicate the 1.5-inch square tube is the correct choice for this part. 
 
[image: Preview of file for tube cutting]


Engrave & Raster Settings 
The engrave function will engrave directly on a line in your CAD file. This function is perfect for marking bend lines. The default settings cannot be changed and will work for all materials. 
The Raster function will engrave between lines in a solid object such as text or an image. The DPI (dots-per-inch) default settings for each material will generally provide good results. To obtain deeper or darker results, uncheck the default box and adjust your ‘Raster DPI (X) to a higher number. Adjusting the ‘Raster DPI (Y) settings will not affect the raster quality as much, but you can experiment if you wish. 
[image: raster settings menu]
Accept 
When all of your settings have been chosen click the green Accept box. This will allow you to move on the Process and Job tabs. 
 
[image: accept button]


‘PROCESS’ TAB 
The Process tab allows you to add tabs to your cut parts and set a kerf compensation. Tabs MUST be added to every cut process. Kerf compensation ensures the laser locates away from your cut line to obtain the correct finished part size. 
 
[image: process menu for adding tabs]
 
Adding Tabs 
All parts being cut on sheet or tube REQUIRE tabs to be added along the cut lines. If tabs are not added your finished part will “tip” and cause the laser to crash. 
Cut parts are easily released from the tabs by first removing your sheet or tube from the laser, setting it on a table or cart, and lightly tapping on your parts with a hammer and chisel. 
Click on the ‘Tabs” icon to open the tab options. 
 
[image: process menu to insert the tabs]
Tabs on Sheets 
· Tabs can be added to sheet parts by choosing the “Insert” button, then clicking on cut outlines where you want tabs to appear. 
· Tabs can be deleted by choosing the “Delete” button, then clicking on the tabs to be removed. 
· Tabs can be moved by choosing the “Move” button, and clicking and dragging on tabs. 
 
[image: process menu to insert tabs]
 
Tabs on Tubes 
· Tabs are automatically added for tubes. 
· Tabs can be moved together. 
· Tabs can be added separately. 
· If you attempt to delete tabs a warning will pop up. Click ‘cancel’ as tabs are required on all cuts. 
 

Round Tube: 3D Cuts vs. 2D Cuts 
Holes and other cutouts on round tubes are automatically cut by rotating the tube during the cut, creating a 3D cut. It is possible to create 2D cuts that are comparable to a drilled or milled hole or cutout. 
· Verify that the geometry you want to change is in the ‘Cut’ group. This action is performed on the ‘Part’ tab. 
· Click on the ‘2D Cuts’ button. 
 
[image: process menu to add kerf]
· A ‘2D Cuts Editing’ section will appear 
 
[image: 2D cuts editing menu]
· Click ‘Select’ 
· Click on the geometry you want to be a 2D cut. The geometry will turn black. 
· Click ‘UnSelect’ and the geometry will return to a 3D cut and change to green. 
· By default geometry must be less than the radius of the tube in order to be selected. This can be increased under the ‘Edit” tab on the top bar, not the ‘Combo View’ Edit tab, as shown here: 
· `Edit>Preferences>Global>Machine Properties>Round Tube 2D Cut Factor 
[image: preferences menu]
· Click ‘Apply’. 
 
 
 
 
Kerf Compensation 
Kerf compensation automatically accounts for the amount of material removed by the laser during a cut. FabCreator will automatically detect if the laser should cut inside or outside of a line and place the laser in the correct cut position so that your finished part will be cut to the dimensions drawn. The default setting of 0.127mm, or 0.005in, will give the best results. 
‘JOB’ TAB 
After all the geometry has been processed, the Job tab allows the file to be previewed, show the path the laser will travel during the cut process, and allow you to duplicate your parts (Step & Repeat). 
Show Job Preview 
· For 2D pieces: highlights the overall part cutout. 
· For tubes: renders what the wrapped tube part will look like. 
Show Slews 
· Shows the paths that the cut head will take between features. 

Step & Repeat (Nesting) 
Step & Repeat allows you to multiply, or duplicate, same parts to be cut on a single sheet or tube. It also allows you to maximize the use of your material. Copy/paste does not work in FabCreator. 
 
By turning on Step & Repeat, a single part can be arrayed on both the X and Y axis for sheet and the X axis for tube. You can also set the gap between parts, the bounding box, and your material. 
[image: Step and repeat menu]
 
 
 
Click on ‘Apply’ to save your settings. 
You can maximize the number of parts that you can cut out of your sheet by clicking ‘Auto Fill Sheet’ and entering the sheet size. FabCreator will automatically set up an array within the specified sheet size and according to your ‘Gap’ and ‘Min Border’ values. You can center the generated array by clicking on ‘Center’. 
[image: job menu]
 
 
Click on ‘Apply’ to save your settings. 
For multiple and identical parts on tube, step & repeat for the X value. You may also use Auto Fill. 
[image: job menu with step and repeat for tube]
 
 
Click on ‘Apply’ to save your settings. 
 


Job Information 
Job Information shows your job time and material specifications. Job time is information you will need to pay for cuts made with nitrogen. All nitrogen use is fee based. See NIS staff for current cost. 
 
See ‘Nitrogen Feed Selection’ in the Operator Manual for setup instructions. 
SAVING YOUR FILE 
When all your file settings are complete you will need to save your file as a .fab file to your flash drive. Bring your flash drive to the FabLight Laser and reference the Operator Manual to proceed with the cutting of your parts. 
There are two processes to create your .fab file 
 
 
· On the ‘JOB’ tab click the green ‘MAKE AND SAVE’ button located at the bottom of the left side of screen. 
 
[image: job information menu]
· Click >File>Make and Save. 
 
 
[image: make and save menu]


USING VCARVE WITH FABCREATOR 

SOP 
CNC FIBER LASER 
FABCREATOR SOFTWARE 
 
[image: fablight laser engraving and cutting machine]
Nebraska Innovation Studio 
 
 
 
 
[image: Nebraska innovation campus and University of Nebraska - Lincoln logos]
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